# Table of Contents

Movavi Video Converter 14 .......................................................................................................................... 3
Overview ....................................................................................................................................................... 4
System Requirements ................................................................................................................................. 5
Supported Formats ....................................................................................................................................... 6
Program Settings ......................................................................................................................................... 7
Hardware Acceleration ............................................................................................................................... 11
Activating Software ................................................................................................................................... 13
Online Activation ....................................................................................................................................... 15
Offline Activation ....................................................................................................................................... 18
License Types ............................................................................................................................................... 22
Trial Limitations ........................................................................................................................................ 23
Quick Start Guide ........................................................................................................................................ 24
Movavi Video Converter Interface ............................................................................................................ 27
Main Converter Window ............................................................................................................................ 28
File List ...................................................................................................................................................... 30
Preview Area .............................................................................................................................................. 32
Preset Tree ............................................................................................................................................... 34
Converting Video and Audio ...................................................................................................................... 37
Adding Media for Conversion .................................................................................................................. 38
Choosing an Output Format .................................................................................................................... 39
Converting for Devices ............................................................................................................................. 41
Converting Videos for the Internet ......................................................................................................... 42
Extracting Audio from Video .................................................................................................................. 44
Converting Audio ..................................................................................................................................... 46
Burning DVDs ........................................................................................................................................... 48
Changing the Output Path ....................................................................................................................... 50
SuperSpeed Conversion ........................................................................................................................... 51
Enabling SuperSpeed Conversion ....................................................................................................... 52
SuperSpeed Indication ............................................................................................................................. 53
Compatible Formats ................................................................................................................................. 54
Conversion Options .................................................................................................................................. 55
Export Options ........................................................................................................................................... 56
Joining Files ............................................................................................................................................... 58
Trimming Video and Audio ..................................................................................................................... 60
Reducing Video Size ................................................................................................................................. 61
Selecting and Adding Tracks .................................................................................................................. 62
Rotating Videos .......................................................................................................................................... 63
Video Adjustments .................................................................................................................................... 64
Contacting Support .................................................................................................................................. 65
Welcome to **Movavi Video Converter** User's Manual! Here you will find the detailed instructions on how to process media files in Movavi Video Converter 14!
Overview
This chapter provides general information about Movavi Video Converter:

- **System Requirements**
- **Supported Formats**
- **Program Settings**
- **Hardware Acceleration**
- **SuperSpeed Conversion**
System Requirements

Minimum System Requirements:

- Microsoft Windows XP/Vista/7/8 with up-to-date patches/service packs installed
- Intel or AMD or compatible processors, 1 GHz
- Display resolution of 1024x768, 32-bit color
- 256 MB RAM for Windows XP, 512 MB for Vista, 1 GB for Windows 7 and Windows 8
- Minimum 250 MB free hard disk space for installation, 2 GB for ongoing operations
- Latest version of QuickTime Player for Windows for MOV file processing
- Administrator permissions are required for installation

Recommended System Requirements for HD Video Conversion:

- Microsoft Windows XP/Vista/7/8 with up-to-date patches/service packs installed
- Intel or AMD or compatible processors, 1 GHz or higher
- Display resolution of 1280x1024 (or higher), 32-bit color
- 1 GB RAM for Windows XP, 2 GB for Vista, Windows 7 and Windows 8
- 5 GB free hard disk space for ongoing operations; conversion of HD video may require large amount of free disk space, up to several 10’s of GB
- Conversion speed acceleration requires an Intel® processor with Intel® HD Graphics second generation (or higher) support or an NVIDIA® CUDA™-enabled graphic card
- Latest version of QuickTime Player for Windows for MOV file processing
- Administrator permissions are required for installation
- Sound card
Movavi Video Converter Settings and Preferences

The application settings for Movavi Video Converter are accessible via the **Settings** Menu category in the Menu bar:

![Menu bar with Settings category]

Clicking the **Settings** Menu category will display the following options:

- **Language** – this menu item expands into a list of languages: clicking one of them will change the program's interface language.
  - **More Languages** – this item leads to a webpage where you can download additional language packs or request support for new languages.
- **Theme** – expand the list and select one of the available themes to change the visual appearance of the Converter interface.
- **Preferences** – opens the Preferences window. The various preferences are organized into three tabs:

  I. **The General** tab allows you to change the language and update preferences.

  - Check the **Automatically check for updates** box to make sure your Video Converter is always up-to-date.

  - **Send anonymous usage stats to Movavi** – checking this box will allow Movavi Video Converter to send usage statistics to our development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data sent by Movavi Video Converter contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only. You can find more information about usage statistics on our [Movavi Improvement Program](#) page.

  - **Show hints and tips** – toggles whether the program will display help pop-ups. You can also check **Don't show this message again** on any pop-up to turn it off.
II. The **Conversion** tab contains the following options:

**Output file name** – determines the course of action if the output folder already contains a file with the specified name when a new file is being placed into the folder during conversion:

- **Overwrite existing file** - the old file will be permanently replaced with the newly converted file.
- **Automatically rename files** - new files will be automatically renamed, and both files will be preserved.

After conversion:

- **Open output folder** - if this option is enabled, the folder containing your newly converted files will be opened automatically as soon as the conversion process is finished.
- **Play notification sound** - if this option is enabled, the program will notify you when it has finished converting your files.
III. In the **Acceleration** tab, you can enable or disable various acceleration options. You can find out more about each acceleration method in the [following section](#).

**Enable SuperSpeed conversion**: check this option to enjoy unmatched conversion speeds for compatible formats.

**Enable Intel hardware acceleration**: this option allows you to employ your Intel multi-core processor’s full potential when converting media files.

**Enable NVIDIA GPU acceleration**: this option allows Movavi Video Converter to shift video processing to your CUDA-enabled NVIDIA Graphics Card, freeing up the CPU for use by other processes.
• And finally, the **Show Player** option toggles the player visibility. You can also enable and disable the player using the dedicated button beneath the **File List**.
Hardware Acceleration

In addition to its lightning-fast conversion engine, Movavi Video Converter can further speed up video and audio processing using the latest hardware and software acceleration methods.

Intel HD Graphics Hardware Acceleration
Movavi Video Converter is optimized for use with Intel® multi-core processors, such as the Intel® Core™ i5, and i7 CPUs that support the Intel® Quick Sync technology. The latest Intel® processors are empowered with a dedicated media processing chip that can be used for media decoding and encoding by Movavi Video Converter. With Intel® acceleration enabled, Movavi Video Converter can convert media streams up to 3.5 times faster by shifting some of the workload from the main CPU.

Support for Intel® Quick Sync technology also allows you to enjoy smoother performance on your computer while running media conversion, as your computer's resources are more efficiently distributed between the CPU cores and your Intel processor's graphics chip.

NVIDIA® CUDA™ Hardware Acceleration
Many computers today not only have advanced multi-core processors, but are also equipped with cutting-edge multi-core graphics cards that can process video and audio streams just as effectively as many CPUs. Enabling NVIDIA® GPU acceleration will allow Movavi Video Converter to employ your NVIDIA® graphics card for media processing, increasing conversion speeds even further!

CUDA™ technology saves you time when processing AVI, MP4, FLV, MKV, MPEG2-TS with H.264 codec, MPEG (MPEG2-PS, MPEG2-TS) with MPEG1/MPEG2 codec, WMV with VC-1 codec to AVI, FLV, MP4, MKV with H.264 codec. If you have NVIDIA® GPU acceleration enabled, Movavi Video Converter will notify you if NVIDIA® acceleration is available.

Enabling Intel® and NVIDIA® acceleration:
In the main window of Movavi Video Converter, open the Settings menu and select Preferences. The Preferences window will appear. Click the Acceleration button at the top to switch to the Acceleration tab. Then, simply check the corresponding checkboxes to enable Intel® or NVIDIA® hardware acceleration and click OK to apply the changes and close the window.
Enable SuperSpeed conversion
Learn more

Enable Intel® hardware acceleration
Learn more

Enable NVIDIA GPU acceleration
Learn more
When you purchase a copy of Movavi Software, an Activation Key will be sent to the email you have specified at checkout. You will need to enter this Activation Key into the program to activate it and remove the trial limitations. This way you will not have to re-download or reinstall the software.

The Activation Key you receive can be used up to six times if you wish to reinstall the software or your operating system. When you have used up your key's activation count, you can always contact support to receive a new one. However, please note that the Activation Key can only be used on one computer.

Online Activation is the quickest and easiest way to activate your software, however, it requires a stable Internet connection.

If you do not have a stable Internet connection, you can use Offline Activation: your program can be activated by by sending an automatically generated e-mail to our Activation server and then entering the reply into the program. Even though an Internet connection is still required to send an e-mail, you can send it from any other computer, not necessarily the one that Movavi software is installed on.

How to Activate Movavi Video Converter:

In the main window of Movavi Video Converter, click the Help menu and select Activate Software. This will open the Activation Wizard.

Depending on whether you have Internet access at the moment of activation, please refer to the following sections:

- Online Activation - if you have a stable Internet connection.
- Offline Activation - this will require you to send an e-mail to our activation server, but this can be done using any other computer.
If you did not receive a letter with your Activation Key after purchasing the program, please try the following:

- Check the 'Spam' folder in your mailbox.
- Contact support
Online Activation

Automatic (Online) Activation is a fast and easy way to activate your software when the computer on which you installed your Movavi software has a working Internet connection.

To carry out the activation process, make sure your computer is connected to the Internet and follow these simple steps:

Step 1:

- Launch the Movavi program you purchased.
- In the main menu choose Help > Activate Software.
- When the Activation Wizard starts, click Next to continue.

![Activation Wizard](image)

Step 2:

- Enter the activation key you received when you bought your Movavi software into the corresponding box in the Activation Wizard dialog box.
- Choose Internet Activation.
- Click Next to activate the program.
Step 3:
Upon completing the activation process, you will see a message stating that the activation of your Movavi program has been successful.
Click Finish to close the Activation Wizard.

If online activation fails, try the following:
- Make sure you have administrator rights on your computer.
• Try disabling your computer's firewall.

If online activation keeps failing anyway, try Manual (Offline) Activation.

If you have any questions or problems while activating your Movavi software, please don't hesitate to contact our technical support team.
Offline Activation

Step 1.

- Launch the Movavi program you purchased.
- In the main menu, go to Help > Activate Software.
- When the Activation Wizard starts, click Next to continue.

Step 2.

- Enter the activation key you received when you purchased your Movavi software into the corresponding box in the Activation Wizard dialog box.
- Choose Offline Activation.
- Click Next.
Step 3.
To complete this step, you will need to send us an e-mail containing some specific information. Once you've sent us the information, you will receive an e-mail from us with your registration key, which you can then use to complete the registration process. Note that you can complete this step using any computer connected to the Internet (not necessarily the computer on which you installed your Movavi software).
• Click **Copy** to copy all the required information (Activation key, Hardware ID, and Product ID) from the Activation Wizard dialog box to the clipboard. To save the information as a file, click **Save**.
• Paste the information into the body of a new e-mail and send it to Movavi at reg@movavi.com.

To ensure a fast response from the activation server, please do not change the information in the message body or subject field.

![Activation Wizard](image)

After your information is processed, you will receive an reply with your registration key. Please allow up to one hour for this step.

**Step 4.**

• Copy the registration key from the e-mail into the corresponding box in the Activation Wizard dialog box.
• Enter your registration name into the corresponding box.
• Click **Next** to submit the information.

![Offline Activation](image)

**Step 5.**

Upon completing the activation process, you will see a message confirming that your Movavi program has been successfully activated.
- Click **Finish** to close the Activation Wizard.
If you have any questions or problems when activating Movavi software, please don't hesitate to contact our technical support team at support@movavi.com
License Types

Movavi software is licensed on a per computer basis, meaning that each copy of Movavi software installed on different machines will need a unique license key.

Movavi offers two license types depending on the intended use of the software:

The **Personal license**, suitable for home use, can be used for any kind of personal purposes, projects, websites, etc., without the aim of obtaining profit.

The **Business license** is intended for professional use in commercial environments as well as government institutions, and must be purchased if it will be used to receive profit.

If you have any questions or concerns regarding Movavi software licensing, you're welcome to visit our help center or contact our support team at support@movavi.com.

Once you've purchased a license for **Movavi Video Converter** and received your activation key, you will need to activate your copy of the program.

There are two ways to activate **Movavi** software:

- **Automatic (Online) Activation** — the fastest and easiest way to activate the program. It is the recommended option if the computer on which you install **Movavi** software is connected to the Internet.
- **Manual (Offline) Activation** - recommended when the computer on which **Movavi** software is installed cannot be connected to the Internet, or when the online activation fails.
Before you activate Movavi Video Converter, it will be running in Trial mode. The trial contains all of the features of the full version, however the trial version is limited in the following ways:

- The Trial lasts only 7 days since installation. After that, you will be offered to activate the software or purchase an Activation Key.
- A watermark will be added on top of converted videos
- Audio files will only be converted 1/2 length
- When using SuperSpeed mode, files will only be converted 1/2 length.
Quick Start Guide

Using Movavi Video Converter, you can perform any kind of format change in just a few steps – the procedure will not be significantly different no matter which formats you are converting to or from.

Hints and Tips:
When you first launch Movavi Video Converter, you will be offered a quick walk-through with pop-up hints. Just follow the on-screen instructions and you'll be converting videos like a pro in no time! If you want to disable the hints, please see the Program Settings section.

Step 1: Add Files

To start with, you will need to add some files into the program. To do that, use the buttons at the top of the window:

- **Add Video**
- **Add Audio**
- **Add DVD**

Step 2: Choose a Preset

Click the drop-down arrow next to the Convert to field to open the list of presets. They are divided into format and device presets:

- **More presets for formats** opens a list of formats such as MP4, AVI, MOV, and others, each complete with a set of various resolutions;
- **More presets for devices** opens a list of device types and brands, which you can browse to find your particular device's model. Using one of these presets will automatically convert media with such settings that it will be playable on this device out of the box.
For example, to convert your videos for the iPad mini, you will need to go to More presets for devices, open the Apple category, and select iPad mini.

You can even prepare your videos for uploading to social networks: go to More presets for formats, open the Online Video category, and select the service and resolution that you prefer, for example, YouTube HD 720p. Or, if you just need to change the format, you can quickly access the most popular formats under More presets for formats > General Video.

Most format categories offer you a selection of resolutions, however, there will always be a Same as input option which you can select if you want to keep the same resolution for this video after conversion.

**Step 3: Start Converting!**

Now almost everything is ready to start converting your media files. All that's left is to set a destination where the program will store the new files.

To do that, check the Destination field right underneath the Convert to line. By default, the files will be saved in the Movavi Library folder, located in your Videos directory. If you want to change the output folder, just click the Browse button to the right and specify the necessary folder in the dialogue window.

Once you're all set, click the Convert button in the bottom right corner and the Converter will start processing your files.
This chapter presents the Movavi Video Converter user interface and its elements:

- Main Converter Window
- File List
- Preview Area
- Preset Tree
The main Movavi Video Converter window consists of the following elements:

1. **Main Menu**
   The main program menu contains various options and settings, most of which are accessible through buttons in the main interface.

2. **Add Media Buttons**
   Use these buttons to add video, audio files, and entire DVDs.

3. **File List**
   The File List contains vital information about your files and allows you to manage some output settings. You can find a detailed run-down of the File List interface in the next section.

4. **Preview Area**
   The Preview Area allows you to play back the selected file.

5. **Effects**
   The Rotate and Adjust buttons allow you to apply various effects to your video.

6. **Convert to...**
   Clicking the Convert to line will open the list of ready-made presets for a variety of formats and devices.

7. **Destination Field**
   The Destination field displays where the converted files will be saved. The default destination is your Movavi Library folder.
Checking these checkboxes prior to launching the conversion will allow you to join files together, add files to iTunes, upload them to various video hosting websites using the ShareOnline module, and record a DVD using the ChiliBurner module.

Clicking this button will bring up the selected format's Settings window, where you can change the resolution, bitrate, and other parameters.

Clicking this button will launch the conversion process.
This is the File List, where you can see information about added files, their output parameters, and select tracks.

**Input Column**
Information about the input file will be displayed in the Input column.

**Output Column**
Information about the output file, such as its name, estimated size, and selected preset will be displayed in the Output column.

**Select File Checkbox**
The checkboxes next to each file display whether that file is selected for conversion: unchecked files will be skipped when you start the conversion process, but kept in the file list – for example, if you want to convert them in the next batch. You can use the uppermost checkbox to select all or no files.

**Remove File Button**
Clicking the X button will remove the corresponding file from the playlist. The uppermost X button will remove all the files from the list.

**Selected File Information**
This is the file you have currently selected. You can play it back in the Preview area.

**Output Preset**
Here, you can see which format the file will be converted to. You can also find this information in the Convert to field in the bottom part of the Converter window.

**Output File Size**
The number represents the approximate size of the output file. Clicking this number will bring up a dialogue which allows you to set the compression rate if you need a smaller file size.

**Output File Name**

By default, the file will be saved with the same name as the original, however you can click the filename to change it.

**Track Selection**

This column displays the selected video, audio, and subtitle tracks. You can click the corresponding arrows to bring up a selection of available tracks, or to turn off the track completely.

Furthermore, right-clicking a file in the **File List** will bring back the following context menu:

- **Play/Pause** - toggles the selected file’s playback in the Preview Area.
- **Duplicate** - duplicates the selected entry in the file list.
- **Remove** - deletes the selected file from the list.
- **Remove All** - clears the File List.
- **Rename** - allows you to rename the selected output file
- **File Information** - brings up the File Information window which contains detailed information about the video and audio streams.
The Preview Area is essentially a built-in player that allows you to preview your video and also trim its length using the Trim markers in the Progress bar.

**Unpin Player Button**
Clicking this button will unpin the player into a separate window. This is especially useful if you have two monitors. You can always double-click the player window's Title Bar to bring it back.

**Hide Player Button**
Clicking this button will hide the player. You can bring it back using the Show/Hide Player button beneath the File List or using the Playback menu.

**Preview Video**
This is your video! Isn't it great?

**Progress Bar**
The Progress Bar displays the current playback position and the file's duration. It also contains Left and Right markers which can be used to trim your video.
Preview Mode Toggle

Use these buttons to switch the preview mode: Input mode will display the original video, and Output mode will display how your output video will approximately look like in terms of size, proportions, video quality, etc.

Play Button

Clicking this button will start the selected file's playback.

Previous Frame Button

Clicking this button will rewind the video by one frame backward.

Next Frame Button

Clicking this button will skip one frame forward.

Full Screen

Clicking this button will turn on the full screen preview mode.

Volume

Clicking this button will bring up the volume control where you can set the volume level for the preview. It will not affect the volume of the output video after conversion.
Preset Tree

Selecting which format your files will be converted to is done with the help of **presets**: each preset contains a set of pre-defined settings related to the selected format, configured in such a way that you would be able to convert video and audio with the optimal parameters. Since you may need to convert media for a wide variety of formats, devices, with various codecs, resolutions, et cetera, we've organized the multitude of presets into a convenient **Preset Tree**, which you can use to easily find exactly the one you need.

To open the Preset tree, find the **Convert to** field in the bottom part of the converter interface and click anywhere within it. The **Preset List** will appear. On the first screen, you will see your most recently used presets, and if you haven't used any presets yet, it will display some of the most popular video formats.

Beneath the list of formats, you will also see two options:

- **More presets for formats** - click this option to see a list of format presets,
- **More presets for devices** - click this option if you want to convert videos for a particular device.

And finally, you can also use the search bar to find the necessary format or device presets:

If you click the **More presets for formats** option, you will first see a list of general categories:

- **General Video** - contains a list of presets for the most popular formats, such as AVI, MP4, MKV, and others. You can use this category if you do not have specific requirements and just need to change a video's format.
- **DVD-Compatible Video** - choosing one of these presets will convert your video into a DVD-compatible format, meaning that the converted video will be ready to be recorded to a DVD straight after conversion without any additional encoding.
- **HD Video** - this category contains some popular formats for HD videos in 720p and 1080p resolutions.
- **Online Video** - if your goal is to upload your video to a video hosting service such as YouTube or Facebook, use one of these presets to ensure that your videos are in a format that these services accept. You can also use the **Share Online** module for uploading the videos right after conversion.
- **Web-Compatible Video** - this category contains presets for formats that are best for embedding into blogs and websites, such as FLV and WebM.
Beneath these categories, you will see an alphabetical list of **video format** groups. Click on each format category to see a list of presets for different codecs and resolutions. Click a category title again to collapse the list of its subitems. Click on any item within a category to select it as your output preset.

**Audio format** groups can be found at the very bottom of the list. Each group contains a set of presets for various bitrate and quality options.

If you want to go back to the main Preset List screen, click **Back**.

If you click the **More presets for devices** option, you will see an alphabetically organized list of device types (such as Android) and manufacturers (like Apple or Blackberry).

To find a preset for a particular device:

Find your device's manufacturer. For example, if you need to convert a video for BlackBerry Bold 9000, you will need to find the Blackberry group. Click the group to expand it. Then, click a list item to select this device's preset – for our example we would need the **Blackberry Bold 9000, 9700** preset.
Remember that you can save time by using the **Search bar** at the bottom!
Converting Video and Audio

This section will describe the procedure of converting media for a number of situations, as well as some additional actions Movavi Video Converter can help you with. For a basic tutorial of the converting process, please refer to the Quick Start Guide section of this manual.

- Adding Media for Conversion
- Choosing an Output Format
- Converting for Devices
- Converting Videos for the Internet
- Extracting Audio from Video
- Converting Audio
- Burning DVDs
Adding Media for Conversion

There are several ways of adding media files to the converter.

Adding Video and Audio Files:
Before converting media files, you will need to add them to the File List. You can do that using one of the following ways:

1. Drag video or audio files from Windows Explorer onto the File List. The files will automatically be added to the list.

2. Use the buttons:
   - ![Add Video](image)
   - ![Add Audio](image)
   - ![Add DVD](image)

3. Open the File menu and select one of the menu items:
   - Add Video - for adding video files
   - Add Audio - for adding audio files
   - Add DVD - for adding DVDs
   - Add Folder - add the contents of an entire folder at once

4. In Windows Explorer, right-click the necessary media file and select the Movavi Convert to... option in the context menu.
   * You will need to have checked the Add the "Convert to" option to the context menu during installation.

Adding DVDs:
1. Click the Add DVD button in the upper left part of the converter window or open the File menu and click Add DVD.
2. The Open DVD dialog will appear. Navigate to the VIDEO_TS folder on your DVD and click Open Folder.
3. The files on your DVD will be added to the list in the correct order, with the main movies and bonus files labeled appropriately.
Choosing an Output Format

For your convenience, selecting an output format in Movavi Video Converter is done using Presets. A Preset is a combination of parameters such as video and/or audio codec, frame size, and bitrate that can help you convert media files with the optimal quality. These settings can be changed at any time, and you can even create any number of your own presets.

To select an output preset:
1. Click anywhere inside the Convert to field located in the lower part of the converter interface. The Preset List will appear. Here you will be able to see your most recently used presets.

2. Click the More presets for formats item to access the list of video and audio formats.

3. You will see a list of format groups. Click the necessary group to expand it. You will then be offered a choice of several resolution sizes, as well as an option labeled Same as input that allows you to convert the video without changing its resolution. Some format groups, such as MP4, also allow you to choose a video codec if the selected format supports more than one.

4. Click the necessary preset to select it.
5. (Optional) If you need to fine-tune the output video settings, click the **Settings** button to the right of the **Convert to** field to access the settings for the chosen format. Here you will be able to manually set the video codec, frame size, bitrate type, and more. Switch to the **Audio** tab at the top of the **Settings** window to access the audio channel settings.

**Tip:** If you can't find the necessary parameter, click **Show Advanced** to see even more settings.

Now that you've selected an output format, all that's left is to set a destination path and start the video processing by clicking the **Convert** button in the bottom right corner!
Converting for Devices

You can convert video and audio for mobile devices just as easily as any other type of conversion. Movavi Video Converter includes a wide variety of device presets, each tailored especially for a particular device to ensure that your video will be played out of the box, without the need to install any additional codecs or players.

To convert media for a mobile device:
1. Add video, audio files or DVD into the program.

2. Click the Convert to field in the bottom part of the converter interface to open the list of Presets.

3. Click More presets for devices. You will now see a list of presets for various device types and brands.

4. Find the group with your device's brand. Click the group to expand it and show the related devices.

5. Find your particular device model in the group you have just opened. Click that line to select it as the output preset.

For example, if you want to convert a video for the Google Nexus 5 smartphone, you will need to open the Google Nexus group and select the Google Nexus 5 preset.

Once you're done, you'll only need to set a folder for the output files and click Convert to start the conversion process.
Converting Videos for the Internet

To upload a video online, whether to a personal website or to a video hosting service, you will need to do two things: convert it into a suitable format and upload it onto the web. Movavi Video Converter can help you with both of those things. Just follow the steps below.

Step 1: Add the Video into the Program

Click Add Video or Add DVD to add videos to the File List:

Step 2: Select a Preset

Click the Convert to field to open the list of Presets. Then, click on More presets for formats. You will see a number of groups.

A. If you want to upload your video to a video hosting site or a social network, select a preset from the Online Video category depending on which website it is intended for and which resolution you prefer. If you're not sure which website is best for uploading videos, you can consult our comparison page.
B. If you want to upload the videos to your own website or blog and have some control over which formats to use, you can select one of the presets from the **Web-Compatible Video** group. These include MP4, FLV, SWF and WebM, considered to be the most convenient formats for uploading videos online.

**Step 3: Choose a Destination Folder and Convert**

Make sure that the **Destination** line shows the correct folder. If not, click **Browse** and specify the folder to store your videos in. Once you’re ready, click **Convert** to start the video processing. When your videos are ready, all that’s left is to either upload them to the video hosting service you prefer, or upload them to your website’s server and create a link to your video.
Extracting Audio from Video

Movavi Video Converter can help you convert not only video files into other video formats, but also convert video files to audio formats, thus extracting the soundtrack from your videos.

1. Add video files or DVDs to the program.

2. Select a video fragment that you want to extract the audio from. In the Preview Area, drag the markers from the beginning and the end of the progress bar so that the necessary fragment is located between them. This way, you can save only the part you need without having to cut the audio file later.

3. Select an audio preset:

   3.1 Click the Convert to field to open the list of presets.
   3.2 Open the More presets for formats category and scroll to the bottom to find audio preset groups.
   3.3 Open one of the audio preset groups and choose a bitrate you prefer. To preserve the original quality, choose a preset labeled with Same as input.

Higher audio bitrates generally mean higher quality, however the file size will also be larger.
4. Check the **Destination** line to make sure you're saving your audio into the right folder and click **Convert** to start converting video into audio!

* Please note that Movavi Video Converter is not intended for making illegal copies of copyrighted material.
Converting Audio

Even though MP3 is still the most frequently used audio format, there are ample reasons to use other audio formats, such as better quality, higher compression, etc. On the other hand, just as with video formats, there may arise incompatibility issues across different platforms, players, and devices, which can be solved by converting the files into a more widely supported format.

Step 1: Add Files

To add audio files to the file list, click the button at the top of the window and select the files you want to convert.

Step 2: Choose a Preset

Click the Convert to field to open the list of presets and go to More presets for formats. Scroll to the very bottom of the list to find audio format groups. The General Audio group contains presets for converting the audio to various formats, retaining the original quality. The other groups contain presets of various bitrates for a single format. The bitrate determines the amount of data that can be played back each second of audio and directly impacts the audio quality. Higher bitrates generally mean higher quality, however, it also implies larger file size.

Step 3: Set a Destination Folder and Convert

The Destination line displays the file path to where the program will place the converted files. To change this folder, click Browse and select the necessary folder using the standard Windows dialogue.

If you want to add the files to your iTunes library after conversion, just tick the Add to iTunes checkbox beneath the Destination line. Please note that you will need iTunes 6.0 or higher installed on your computer.
When you've set everything up, click **Convert** to start the audio processing. Your files will be ready in a few minutes at most.
Burning DVDs

Please note that you will need to have Movavi ChiliBurner or Movavi Video Suite installed to use the DVD burning feature.

You can use Movavi Video Converter to prepare videos for burning to DVDs with Movavi ChiliBurner.

1. Add videos for conversion using the Add Video or Add DVD buttons located in the upper part of the main converter window or simply drag-and-drop files from Windows Explorer.

2. Select the necessary preset:
   Click anywhere within the Convert to field to open the preset list and go to More presets for formats. There, open the DVD-Compatible Video group and select a preset depending on which TV standard (NTSC or PAL) and quality you need.

3. Now that you've selected a DVD-compatible preset, the Burn to DVD checkbox will appear at the bottom of the window. Check this box to burn the videos right after conversion.

4. If you will be needing the converted videos later, make sure to check where they will be saved in the Destination line, and if necessary, specify a new one by clicking the Browse button and selecting a new folder in the Explorer dialogue.

5. Click Convert to start the conversion process.
6. Once your files have been processed, the DVD burner module will open. Your files will already be added to its list. All you will need to do now is make sure there is a writable DVD inside your DVD drive and click **Burn Disc**.
Changing the Output Path

The **Destination** line located in the bottom part of the converter interface allows you to change the folder where Movavi Video Converter will place the output files.

![Destination field with example path](image)

The default destination for saving your files is your Movavi Library, located in your C:\Users\Videos folder. However, you can easily change it using one of the following ways:

- Click the **Browse** button and specify the necessary folder using the standard Windows dialogue.
- Click the text in the **Destination** field and type in the necessary path.
- Click the arrow button next to the **Destination** field. This will open a list which will contain the following options:
  - **Your Videos\Movavi Library folder**
  - **The output folder is the same as input**: selecting this option will place the output files right next to the input files.
  - Any folder paths you have recently used.

You can always quickly open the selected folder by clicking the arrow to the right of the Browse button and selecting **Open output folder**. This will open the folder in Windows Explorer so that you can check its contents.
**SuperSpeed Conversion**

The new version of Movavi Video Converter allows you to quickly convert your files between compatible formats without re-encoding and losing quality with the new **SuperSpeed** mode.

SuperSpeed conversion is applicable when you convert files between formats which support the same video or audio codecs, which allows Movavi Video Converter to skip the re-encoding process and simply move the video and audio stream from one format into another, which allows the files to be converted with both unbelievably high speeds and zero quality loss.

However, as SuperSpeed conversion does not re-encode video or audio streams, it can only accelerate conversion under the following conditions:

- The codec, resolution, bitrate, and other video parameters remain unchanged
- The video is not rotated or compressed

Therefore, if you change the video resolution or any other parameters, the conversion will run as usual. Don't worry, it's still very fast!

*Tip: you will still be able to trim your file before conversion in SuperSpeed mode.*
Enabling SuperSpeed Conversion

1. In the main converter window, open the Settings menu and click Preferences to open the program preferences.
2. In the Preferences window, click the Acceleration button to access various acceleration options.
3. Check the very first checkbox: Enable SuperSpeed conversion. Click OK to save your preferences and return to the main window.
**SuperSpeed Indication**

Movavi Video Converter indicates that a file or format supports SuperSpeed conversion in one of the following ways:

1. In the **File List** – if the files you have added into the converter support SuperSpeed conversion into the selected format, your file will have the "**SuperSpeed conversion supported**" label in the Input column.

![File List Screenshot]

2. In the **Preset List** – when you click on **Convert to** and navigate to a preset group, the presets which support SuperSpeed conversion for any of the files you have added will be marked with a green icon. Note that the icon only appears next to presets labeled with **Same as input**, which means that the output file's resolution will remain unchanged.

![Preset List Screenshot]

Please note that if you select a preset marked with the SuperSpeed icon, but decide to change its settings to those incompatible with SuperSpeed mode, conversion will run as usual.
## Compatible Formats
You can use the following table to check whether a particular format can be converted in SuperSpeed mode:

<table>
<thead>
<tr>
<th>Input formats and codecs</th>
<th>AVI (H.264)</th>
<th>FLV (H.264)</th>
<th>M2TS (H.264)</th>
<th>MKV (H.264)</th>
<th>MOV (H.264)</th>
<th>MP4 (H.264)</th>
<th>MPG (MPEG-2)</th>
<th>iPad3</th>
<th>iPad</th>
<th>iPhone 5S, iPhone 5C, iPhone 4, iPhone 4S</th>
<th>Kindle Fire HDX</th>
<th>Kindle Fire HD 8.9&quot;</th>
<th>Kindle Fire HD 7&quot;</th>
<th>Kindle Fire Tablet</th>
<th>Google Nexus 4</th>
<th>Google Nexus 7</th>
<th>Google Nexus 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVI (H.264)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVI (MPEG-4)</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLV (H.264)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M2TS (H.264)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M2TS (MPEG-2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MKV (H.264)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOV (H.264)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MP4 (H.264)</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MP4 (MPEG-4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPG (MPEG-2)</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* SuperSpeed conversion to a device preset is available if the input file resolution is no higher than the device resolution: 1280×720 for iPad 3/4, Amazon Kindle and Google Nexus, 1136×640 for iPhone 5/5C/5S, and 960×640 for iPhone 4/4S.
Conversion Options

In addition to converting your files into over 180 different formats and for a huge number of mobile devices, Movavi Video Converter also provides additional options to make your media processing experience as seamless as possible:

- Exporting files to iTunes and social networks
- Joining files together
- Trimming video and audio
- Reducing video size
- Audio and subtitle track management
- Rotating videos
- Making video adjustments
Export Options
Movavi Video Converter includes various options for sharing your videos with friends, family, or the whole world! You can add your videos to iTunes or upload them to a number of social networks and video hosting sites. What is more, you can do it by simply selecting a checkbox beneath the Destination line.

Adding Videos to iTunes:
If you want to add your files to the iTunes media library after conversion for uploading it to mobile devices or storing them in your iCloud, you can easily do so by checking the Add to iTunes checkbox. Please note that you will need to have iTunes 6.0 and higher installed on your computer before starting the conversion process.

Uploading Videos to the Web:
Please note that you will need to have the Share Online module installed to use the uploading feature. If Share Online is not found on your computer, you will be prompted to download and install it. Don’t worry: it’s completely free, and it shouldn’t take more than a couple minutes! You can always manually download it from our website: http://www.movavi.com/photo-video-uploader/

Check the Upload to checkbox and then click the arrow next to it. You will then see the following pop-up:

Simply put a checkmark next to the websites or services that you want to upload the videos to. Once the conversion process has finished, the Share Online module will open, and you will be able to upload your videos. If necessary, add a description, some tags, change the category and privacy settings and you’re ready to go! Click Upload to start the uploading process.
Joining Files

If you have a collection of video clips that you'd like to make into a single video file, you can easily do it Movavi Video Converter simply by selecting a checkbox. Just follow the steps below:

1. **Add** the media files you want to join.

2. Select the **Join** checkbox beneath the destination line.

All the files in the list will be marked for joining, like on the image below. Your files will be shown as an indented list beneath a "Joined file" - this upper line represents the resulting file which will contain the videos you've selected.

3. To change the order in which the videos will appear in the resulting file, drag and drop the files in the list: they will be joined top to bottom in the specified order.

4. **Choose a preset** for converting the files.

If you are joining files with different resolutions, they will all be converted into the specified preset, however, if you select a preset marked with **Same as input**, the files will be converted with the resolution and other parameters of the first file in the list. You may also want to go into **Settings** and specify a **resize method** that works best your videos, for example, if you want to avoid black bars. Also, please note that SuperSpeed mode is not available when joining files.

5. That's it! All you need to do is click **Convert** to start joining your videos.

**Hint:**
You can also join audio files together, as long as you don’t mix video and audio.
Trimming Video and Audio

If you have a very long and large video but only want to share a part of it with your friends, or you just want to trim some "garbage" from the beginning or the end of the video, follow these steps:

1. **Add media** for conversion. You can trim both video and audio files in the same way.

2. In the [Preview Area](#), drag the triangle sliders from the beginning and the end of the progress bar so that the part of the video you want to keep is located between them.

3. That's it! Don't forget to [choose a preset](#) and [set a destination path](#). When you click the **Convert** button, only the fragment you've selected will be saved in the output file.
Reducing Video Size
Movavi Video Converter can help you not only quickly change the format of video or audio files, but also save disk space by compressing your files. Many format and device presets will help you reduce the size of your output videos by using a smaller resolution, lower bitrate, or simply because some video codecs are better at compressing videos than others. However, you can further reduce video size if you’re prepared to sacrifice some video quality.

1. **Add media** into the program. Use the buttons in the upper left corner of the converter interface to add video, audio files, and DVDs.

2. Choose an output preset:
   - Choose a preset with smaller resolution than that of the original video. This can help significantly cut in size, as even changing the resolution from 1080p to 720p can give save up to a few gigabytes without significant loss of quality. You can find the original video's resolution in the **Input** column of the **File List**.
   - Choose presets with the most recent video codecs, as they have been created with the latest technology in mind and can yield better video compression with smaller quality loss. For example, the H.264 codec is currently considered one of the best codecs in terms of size and quality.

3. Set the compression rate.
   3.1 In the **Output** column of the **File List**, click the orange size link next to the file icon ( ).
   3.2 The compression pop-up will appear. Drag the slider to the left to set a smaller output size, but be aware that this will decrease video quality. You will see the **Quality** and **Bitrate** change as you move the slider.

   ![Compression pop-up](image)

   3.3 Click **Apply** to set the new compression rate. You can do this for each file individually.

4. Set the destination folder for the output files by clicking the **Browse** button and click **Convert** to start the conversion process and compress your videos.
Selecting and Adding Tracks

In our modern day and age, it is not uncommon to find videos with multiple audio and subtitle tracks. However, if you're converting videos for DVDs, mobile devices, or just to save some disc space, you might want to only leave the tracks in your language. You can do just that with Movavi Video Converter, and more: you can even add your own subtitles!

You can select tracks for each file in the **Input** column of the **File List**. Once you add some files into the program, their video, audio and subtitle streams will be displayed in the following way:

**Selecting audio tracks:**

To select one of the available audio tracks, click the arrow next to the sound icon (🔊) to open the list of available audio streams:

Click a stream to select it. This will be the audio stream in the output file. You can also always select **No Audio** if you want your video to be converted without a sound track (for example, if there is no significant information in the audio stream, or the sound quality is very low).

**Selecting or adding subtitles:**

To select one of the available subtitle tracks, click the arrow next to the speech bubble icon (💬)

The subtitle selection list will appear. You can either select an existing subtitle track, or click **Add Subtitles** at the bottom of the list to browse your computer for .srt, .ass, and .ssa subtitle files.
Rotating Videos

It often happens that great videos are filmed upside down or sideways, but you don't have to tilt your head 90 degrees every time when you can just rotate the video. Using Movavi Video Converter, you can do it in just a few clicks:

1. Add videos or DVDs for conversion.

2. Select the video you want to rotate in the File List.

3. Click the Rotate button below the File List. Your video will be rotated by 90 degrees clockwise with each click. You will be able to see the video's current orientation in the player to the right.

Hint: if you do not see a playback area, click the Show Player button right above the Convert button.

The selected video's thumbnail will also be marked with a star icon. Right-click the star icon to see which effects have been applied to it. Here, you can also click the icon next to an effect to remove it.

Now you can go on to choosing a preset and setting a destination path. Once you're done, click Convert to start the video processing.
**Video Adjustments**

Not all videos turn out perfect: some may be slightly darker or less saturated than we want them to be. Luckily, you can adjust your videos' brightness, contrast, hue, and saturation right from the converter!

1. **Add videos** to the file list.

2. Select the video you want to adjust and click the **Adjust** button underneath the file list. The Video Adjustment panel will open.

3. Pull the sliders to set the desired adjustment levels. Make sure that the player is set to **Output** mode so that you will be able to see the changes.

4. Click **Apply** when you're done. The video's thumbnail will now be marked with a star icon. You can right-click it to see a list of applied effects. Here, you can also remove an effect by clicking the ☒ icon next to it.

All that's left is to select an output format, specify a destination folder, and click **Convert** to start video processing.
Contacting Support

If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team. Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster.

The guaranteed response time for e-mails is 3 business days. You can also try our live chat to get a quicker answer.

Our e-mail: support@movavi.com
Phone number: +7 903 902 9831

Phone support is available Monday through Friday, 9 A.M. – 12 P.M.; UTC +7